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About DC Simulation

This documentation describes DC simulation used in ADS. It outlines when to use a DC simulation, how to set it up,
and the data it generates. Examples are provided to show how to use this simulation. Detailed information describes
the parameters, theory of operation, and troubleshooting information.

DC simulation calculates the DC operating point characteristics of a design under test (DUT). DC analysis is
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fundamental to all Analog/RF simulations, so it is used for all Analog/RF designs. Following a topology check, the
simulator performs an analysis of the DC operating point, including the circuit's power consumption.

You can also set up the DC simulation to sweep one or more parameters, enabling you to perform tasks such as
verifying model parameters by comparing the simulated DC transfer characteristics (I-V curves) of the model with
actual measurements.

In ADS, the DC simulation component is available in the Simulation-DC palette.

Refer to the following topics for details on DC simulation:

Using DC Simulation explains when to use DC simulation, describes the minimum setup requirements, and gives
a brief explanation of the DC simulation process.

e Examples of DC Simulation contains detailed examples of DC simulation setups for ADS, one for calculating a
single DC point and another that sweeps variables to generate a set of I-V curves.

e DC Simulation Parameters provides details about the parameters available in ADS for the DC simulation
controller.

e Theory of Operation for DC Simulation provides details about DC simulation operation. This is provided if you
have an interest in understanding the underlying technology. Typical users should not need to examine this
material.

e Troubleshooting a DC Simulation offers suggestions on what to do in the rare event that a DC simulation does
not converge or converges too slowly.

o References for DC Simulation lists the references relevant to the theory of operation. This is provided if you have
an interest in understanding the underlying technology. Typical users should not need to examine this material.

Using DC Simulation

This section describes when to use a DC simulation, how to set it up, and the basic simulation process used to collect
data.

License Requirements

The DC simulation uses the Linear Simulator license (sim_linear). You must have this license to run DC simulations.


http://edocs.soco.agilent.com/display/ads2008/Using+DC+Simulation
http://edocs.soco.agilent.com/display/ads2008/Examples+of+DC+Simulation
http://edocs.soco.agilent.com/display/ads2008/DC+Simulation+Parameters
http://edocs.soco.agilent.com/display/ads2008/Theory+of+Operation+for+DC+Simulation
http://edocs.soco.agilent.com/display/ads2008/Troubleshooting+a+DC+Simulation
http://edocs.soco.agilent.com/display/ads2008/References+for+DC+Simulation
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You can work with examples described here and installed with the software without the license, but you will not be
able to simulate them.

When to Use DC Simulation

A single-point DC simulation automatically precedes every AC, S-parameter, transient, harmonic balance, and circuit
envelope simulation. This serves as the starting point for these simulations. For AC and S-parameter simulations, it
determines linearized models for the nonlinear components. For transient, harmonic balance, and circuit envelope
simulations, it determines an initial estimate used for nonlinear simulation.

A DC simulation also can be done manually in ADS by using the DC simulation controller. Start by creating your
design, add any relevant current probes, then identify and name the nodes from which you want to collect data. The
DC simulation setup then provides for both single-point and swept simulations. Swept variables can be related to
voltage or current source values, or to other component parameter values. By performing a DC swept bias or swept
variable simulation, you can check the operating point of the circuit against a swept parameter such as a bias supply
voltage or a temperature.

Use DC simulation to:

o Verify the proper DC operating characteristics of the design under test.

e Determine the power consumption of your circuit.

o Verify model parameters by comparing the DC transfer characteristics (I-V curves) of the model with actual
measurements.

e Display voltages and currents after a simulation.

e Provide data for DC back-annotation.

How to Use DC Simulation

The following guidelines will help you set up a DC simulation in ADS.

e Add the DC simulation component to the schematic. If you do not edit the default settings, values will be
calculated for the current probes and nodes added to the circuit, based on the settings of the schematic's other
components.

e To sweep a parameter over a range, such as varying an input voltage or changing a resistor value, double-click
the simulation component and select the Sweep tab. Enter the name of the parameter to sweep. Select the
sweep type and enter the range.

o If additional sweeps are needed, an external parameter sweep can be added.

e For details about each parameter, click Help from the open dialog box.
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What Happens During DC Simulation

The DC simulation technique relies on an iterative process of mathematical convergence toward a solution. By
manipulating a system of nonlinear ordinary differential equations, it solves for an equilibrium point in the nonlinear

algebraic equations that describe a circuit based on a set of assumptions. For details, see Theory of Operation for DC
Simulation.

Examples of DC Simulation

There are two examples that describe how to set up and run a DC simulation in ADS:

e Simulating a BJT in ADS shows how to calculate a single-point DC bias of a BJT.

e Sweeping Parameters in ADS shows how to sweep one or more circuit parameters over a range of values during
a simulation.

Simulating a BJT in ADS

The following figure illustrates the setup for a DC simulation of a BJT. This simulation calculates a single DC operating
point.

 Note

This design, DC1.dsn, is in the Examples directory under Tutorial/SimModels_prj. The results are in DC1.dds.
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Setup for a single-point DC bias simulation

To perform a single-point DC simulation:

1. Place the BJT instance and model on the schematic.
2. From the Sources-Freq Domain palette, select V_DC. Place the DC voltage source on the schematic to provide

the collector voltage and modify the voltage as needed.

) Note

Ensure that sources are connected either by wires or by means of a named connection (Insert > Wire/Pin
Label).

3. From the Sources-Freq Domain palette, select I_DC. Place the source on the schematic to provide base current
and modify the current as needed.
4. From the Probe Components palette, select I_Probe. Place this current probe in an appropriate location in the
circuit.
5. From the Simulation-DC palette, select and place the DC simulation component on the schematic.
6. Simulate. When the simulation is finished, you can immediately exercise the following DC simulation options:
e For a direct representation of currents and voltages at all nodes on the schematic, choose Simulate >
Annotate DC Solution.
e For the details of the device, choose Simulate > Detailed Device Operating Point or Brief Device Operating
Point, then click the device when the crosshairs appear.
¢ Choose Simulate > Clear DC Annotation to remove the annotation.
7. In the Data Display, the data from the simulation is presented as a list of DC currents and voltages:

freq DC1. M DC1.yvb .. Probet
0.0000 Hz 3.000% 67g.amy 6T.02uA)

Sweeping Parameters in ADS

By performing a DC swept bias or a swept variable simulation, you can check the operating point of the circuit against
a swept parameter such as temperature or bias supply voltage. The resulting data can be plotted to resemble the
appearance of a curve tracer.

The following figure illustrates a setup for performing an idealized, swept DC bias simulation of a MOSFET. Vdd and
Vgg are swept across a range of voltages. The result is a family of curves representing drain current versus drain
voltage, for varying values of gate voltage.

 Note

This design, DC2.dsn, is in the Examples directory under Tutorial/SimModels_prj. The results are in DC2.dds.
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Example setup for a swept DC simulation

 Note

This example uses a referenced model. The parameter cells refers to the extraction parameter known as
binning and reflects the electrical characteristics of this particular model. The number of cells has been
referenced in a VarEgqn component.

To perform an idealized, swept DC bias simulation:

1. Place the MOSFET instance and model on the schematic.

2. From the Sources-Freq Domain palette, select V_DC. Place this V_DC component (SRC1) between the base of
the device and ground. Edit this component and define Vdc = Vggl, rather than a numerical value.

3. Place another V_DC component (SRC2) between the drain of the device and ground. Open this component and
define Vdc = Vdd1, rather than a numerical value.
This makes it possible to sweep these values. Any swept parameter must be initialized by means of an equation,
as will be demonstrated later.

4. From the Probe Components palette, select I_Probe. Place the probe between the drain and SRC2, and rename it
if you like (in this case, it has been called Probel).

5. From the Simulation-DC palette, select and place the DC simulation component on the schematic.

6. Edit the DC component by selecting the Sweep tab and modifying the sweep parameters as follows:

e Parameter to sweep = Vdd1l. This appears as SweepVar on the schematic if this parameter is displayed on
the schematic.

) Note

Variables entered in this field will appear in quotes on the schematic. If you enter a variable directly on the
schematic (in this case, as the right-hand side of the SweepVar statement of the DC component), you must
surround the variable with double quotes. This applies to the other user-defined variables shown in subsequent

steps.
e Start =0
e Stop =6
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e Step = 0.1
7. Click OK to accept changes and close the dialog box.
8. Choose Simulation-DC palette, select Prm Swp (ParamSweep). Place this component on the schematic and edit it
as follows:
e On the Sweep tab:
° Parameter to sweep = Vggl

° Start = 2
° Stop =3
° Step = 0.25

¢ On the Simulations tab:
° Simulation 1 = DC1. This appears as SimInstanceName[1] on the schematic if this parameter is
displayed on the schematic.
9. Click OK to accept changes and close the dialog box.
10. Choose the Data Items palette, select Var egn (Variables and equations). Place this component on the schematic
and enter the following equations:
e Vddl =4
e Vggl = 2.5
11. Click OK to accept changes and close the dialog box.
12. Simulate. When the simulation is finished, plot the probe current (Probel.i). The resulting family of curves
representing drain current versus drain voltage, for varying values of gate voltage, is shown next:

10
g Wigg1=3,000
R Yag1=2.750
._. 4 _— _ . . . [ Vel A E0f
I 5] Yygl=2.230
|'| - _“{ | | . . . Wl =2 000
=
'2 T | T | T | T | T | T

DC Simulation Parameters

ADS provides access to DC simulation parameters enabling you to define aspects of the simulation listed in the
following table:

Tab Name Description For details, see...
Sweep Defining sweep characteristics. Setting Up a Sweep
Parameters Provides options to set the following: ' Defining Simulation Parameters

e Status levels for summary

9
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information
e Device operating point
information level
e Save output solutions
e Advanced convergence

parameters
Output Selectively save simulation data to a | For details, see Selectively Saving
dataset. and Controlling Simulation Data.
Display Control the visibility of simulation For details, see Displaying Simulation
parameters on the schematic. Parameters on the Schematic.

Additional parameters that you may Additional Parameters
find useful.

Setting Up a Sweep

Setting up the sweep portion of the simulation consists of three basic parts:

¢ Identifying the parameter you want to sweep.
e Selecting the sweep type and setting the associated characteristics.
e Optionally, specifying a sweep plan.

To shorten simulation time in any parameter sweep, select a start point where convergence is easy, and vary the
parameter gradually. When selecting a start point, if you find that convergence is easier at one end of a sweep and
harder at the other, use the easy end as the start of the sweep. Varying the parameter gradually yields better
estimates for the next simulation, and achieves convergence more rapidly than if the parameter is changed abruptly.
However, too small a step can lead to a prohibitively large number of sweep points, so be careful. For additional
information about parameter sweep techniques, see About Preparing Sweeps.

The following table describes the parameter details. Names listed in the Parameter Name column are used in netlists
and on schematics.

DC Simulation Sweep Parameters

Setup Dialog Name Parameter Name

Parameter to sweep SweepVar

Parameter sweep - The sweep type and parameters. Disable Use sweep plan to set these parameters.

10
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Sweep Type

Single point Pt

Linear

Log
Start/Stop Start
Start, Stop, Stop
Step-size, Step
Pts/decade, Dec
Num. of pts. Lin
Center/Span Center
Center, Span, Span
Step-size, Step
Pts./decade, Dec
Num. of pts. Lin
Note: Changes to any of the Start, Stop, etc. fields causes the remaining fields to be
recalculated automatically.

Use sweep plan SweepPlan

About Preparing Sweeps

In ADS, the DC simulation setup dialog enables you to sweep a parameter. You can sweep a parameter using the
internal sweep or use the ParamSweep component for an external sweep. The internal parameter sweep is
recommended over an external parameter sweep when only one parameter is swept. To improve the convergence
process during such an internally swept DC bias simulation, the simulator uses the results from the previous sweep
point as an initial guess for the next sweep point and employs a sophisticated arc-length algorithm. In many cases,
this makes for a faster and more robust simulation than one done with an external ParamSweep component. The
latter simulation simply repeats the DC simulation at each sweep point, with no arc-length continuation. When
multiple parameters are swept, the internal parameter sweep can be employed for one parameter and an external
parameter sweep must be used for the remainder of the parameters.

The results of the swept DC bias simulation are saved in a binary form in a temporary file. This file is used to
post-process selected measurements. Because this file contains all of the results, new measurements can be specified
and displayed without the need for a subsequent simulation.

Defining Simulation Parameters

Defining the simulation parameters consists of three basic parts:

11
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e Specifying the desired level of detail in the simulation status summary.
e Specifying the amount of device operating-point information to save in ADS.
e Optionally, choosing to save all solutions to the dataset.

 Note
Advanced simulation parameters are accessible with this group. However, as a result of the improvements
made to the DC simulation algorithm, it is extremely unlikely that the default values need to be modified. You
are strongly encouraged to leave the advanced parameters set to their default values. If you encounter a
circuit for which a DC analysis does not converge using the default values, or you find it necessary to change
the value of any of these parameters, please contact Agilent EEsof Technical Support. See Defining Advanced
Simulation Parameters for details about these parameters.

! Caution
In ADS, simulator parameters saved in ADS design files in previous releases are supported in later releases.
The advanced simulation parameters saved prior to and opened in ADS 2005A are recognized and populated in
the simulation setup dialog box. However, due to the improvement in robustness and speed of the default DC
simulation algorithm the user-defined values are disabled, and factory-defined default values are used.
Changing these default values is not recommended. However, if you find it necessary to restore the original
user-defined values, you must manually enable Advanced Settings to restore them.

The following table describes the parameter details. Names listed in the Parameter Name column are used in netlists
and on schematics.

DC Simulation Parameters

Setup Dialog Name Parameter Name

Levels - Enables you to set the level of detail in the simulation status report.

Status level StatuslLevel
Device operating point level DevOpPtLevel

None None (0)

Brief Brief (2)

Detailed Detailed (4)
Output solutions

Output solutions at all steps OutputAllSolns
Advanced

Defining Advanced Simulation Parameters

The stand-alone DC simulator's sole role is to do a DC analysis. All other simulators such as AC, S-parameter,

12
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transient, harmonic balance, and circuit envelope do an initial DC analysis as their first step. The advanced simulation
parameters are used for controlling a stand-alone DC simulation. For information about setting DC convergence
parameters for these analyses, see Setting Convergence Options.

The robustness and speed of the default DC analysis algorithm was significantly improved in ADS 2005A. All DC
analyses with factory-default settings are expected to converge to the correct solution with near-optimal speed. This
means that it is extremely unlikely that any of the following advanced simulation parameters must be altered:

ConvMode
MaxDeltaV
MaxIters
MaxStepRatio

MaxShrinkage

ArcMaxStep
ArcLevelMaxStep
ArcMinValue
ArcMaxValue

LimitingMode

The following table describes the parameter details. Names listed in the Parameter Name column are used in netlists

and on schematics.

DC Simulation Advanced Settings Parameters

Setup Dialog Name

Parameter Name

Advanced Settings

Max. Delta V MaxDeltaV
Max. Iterations MaxIters
Mode ConvMode

Auto sequence 0

Newton-Raphson 3

Forward source-level sweep | 4

Rshunt sweep 5

Reverse source-level sweep | 6

Hybrid solver 7

Pseudo transient 8

13
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Arc Max Step

ArcMaxStep

Arc Level Max Step

ArcLevelMaxStep

Arc Min Value

ArcMinValue

Arc Max Value

ArcMaxValue

Max Step Ratio MaxStepRatio
Max Shrinkage MaxShrinkage
Limiting Mode LimitingMode
Global Element 0
Compression
Global Device-based 1
Limiting
Dynamic Element 2
Compression
Dynamic Vector 3
Compression
Global Vector Compression |4
Global Vector Scaling 5
No Limiting 6
Additional Parameters
The following table includes additional parameters that you may find useful.
Additional Parameters
Setup Dialog Name Parameter Name Description

Optimization

Compute Sensitivities Using
Finite Difference

UseFiniteDiff

Perform sensitivity analysis
optimization using the
Finite Difference
approximation method.
This requires N+1 circuit
simulations, where N is the
number of optimization
variables. To set this
parameter in ADS, select

14
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the parameter name on the
Display tab, then enter the
value directly on the
schematic. Allowed values:
yes and no.

Other Use Other to enable access
to hidden parameters, and
assign values to them. The
format is

O her =Hi ddenPar anet er 1=vpl uel
H ddenPar anet er 2=val ue2.
Hidden parameters typically
are used when
troubleshooting
convergence problems. To
set this parameter in ADS,
select the parameter name
on the Display tab, then
enter the value directly on
the schematic.

Restart Restart Use Restart to control how
an External DC Sweep
picks an initial guess.
Allowed values are 1 or 0.
Restart=1 (the default
value) instructs the
External DC Sweep to treat
each sweep point as an
independent DC
simulation.

Restart=0 instructs the
External DC Sweep to use
the solution at each point
as an initial guess for the
next point.

To perform an External DC
Sweep, use a Parameter
Sweep component. Restart
has no effect on internal
DC sweep (which is set
from the Sweep tab of the
DC simulation controller).
Internal DC sweep is an
arc-length continuation
and by definition always
uses the solution at the
current point as an initial
guess for the next

15
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simulation point.

Theory of Operation for DC Simulation

This section discusses the theory of operation for DC simulation. It can help you understand the underlying
technology. Typical users should not need to examine this material.

Simulation Basics

The simulators compute the response of a given circuit to a particular stimulus by converting, based on certain
assumptions, a system of nonlinear ordinary differential circuit equations into a system of nonlinear algebraic
equations and then solving them numerically. The various simulators convert ordinary differential equations to
algebraic equations differently and use different numerical techniques for solving the resulting algebraic equations,
leading to the many different simulator flavors (DC, AC, S-parameter, transient, harmonic balance, circuit envelope).
For example, the DC and the harmonic balance simulators treat the d/dt operator differently, leading to different
algebraic equations. The numerical simulation techniques rely on various iterative processes to achieve mathematical
convergence toward an equilibrium point in the nonlinear algebraic equations that describe the circuit. Once this
equilibrium point is reached to within certain tolerances, a solution is said to have been found.

The specific assumptions for the DC simulator are described in Simulation Assumptions.

Simulation Assumptions

DC voltages and currents are signals of zero frequency. The simulator uses this concept when performing a DC
simulation, and the following conditions apply:

¢ Independent sources are constant valued.

e linear elements are replaced by their (real) conductances at zero frequency.

e Capacitors, microstrip gaps, AC coupled lines, and similar items are treated as open circuits.

e Inductors, conductive discontinuities, and similar items are treated as short circuits.

e Time-derivatives are constant (zero).

e Transmission lines are replaced by DC conductance values calculated from their length, cross-sectional area, and
conductivity.

e Scattering parameter (S-parameter) files must include zero frequency data to operate properly at DC (this is also
required for harmonic balance analysis). Otherwise, the simulator extrapolates each S-parameter for the
zero-frequency case, and uses the real part as the DC response.

e The simulator has built-in safeguards against nodes that are DC-isolated (that have no DC path to ground), as

16
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well as against DC source-inductor loops. Nevertheless, try to avoid these conditions.

For More Details

The descriptions of the various convergence modes in the table DC Simulation Advanced Settings Parameters mention
techniques such as the Newton-Raphson algorithm, source-level sweeping, arc-length continuation, Gmin relaxation,
and pseudo-transient analysis. For more details about these and related techniques, see the publications listed in
References for DC Simulation.

Troubleshooting a DC Simulation

This section presents suggestions for using this simulator and improving the accuracy of results.

The robustness and speed of the default DC analysis algorithm has been significantly improved in ADS 2005A. All DC
analyses with factory-default settings are expected to converge to the correct solution with near-optimal speed. This
means that it is extremely unlikely that any of the following advanced simulation parameters must be altered:

ConvMode ArcMaxStep
MaxDeltaV ArcLevelMaxStep
MaxIters ArcMinValue
MaxStepRatio ArcMaxValue
MaxShrinkage LimitingMode
 Note

As a result of the improvements made to the DC simulation algorithm, it is extremely unlikely that the
factory-default values for the advanced simulation parameters need to be modified. You are strongly
encouraged to leave these parameters set to their default values. If you encounter a circuit for which a DC
analysis does not converge using the default values, or you find it necessary to change the value of any of
these parameters, please contact Agilent EEsof Technical Support. See Defining Advanced Simulation
Parameters for details about these parameters.

Use the following checklist to locate and fix problems. For details about specific problems, see the sections that follow.

e Use the simulator Options to turn on Issue warnings ( GveAllWarnings=yes ) and increase Maximum number of
warnings ( MaxWarnings=10 by default). To set these parameters in ADS, place the Options component on your
schematic from the Simulation-DC palette. For details about simulator options, see Using the Simulator Options

Component.
e Read all error and warning messages from the Simulation/Synthesis Messages window and make corrections

17
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accordingly.

e Read all status information from the Status/Summary window (select Show Complete Status Message under
Window tab) and make corrections accordingly.

e Check your setup for common errors (see Common Setup Errors).

e Loosen the simulation Options parameters for absolute and/or relative simulation tolerances (see Adjusting
Tolerance Parameters).

e Turn on/off the Topology Checker (on by default) using the simulation Options parameters (see Topology Check
and Correction).

e Check if you have created a circuit with no solution (see Impossible Circuits).

e Check if Imax should be increased (see Model Parameter Imax is Too Small).

Common Setup Errors

If your circuit does not converge, or if it converges but your DC I-V curves appear different than expected, it can be
due to one or more of the following reasons:

e Check component and model parameter values and units, especially small series resistor values in model
parameters.

e Check if your independent swept parameters are swapped on the grid display. For example, if SRC1 sweeps a
transistor gate voltage and SRC2 sweeps a drain voltage, and if the current is displayed with SRC1 (gate voltage)
on the x-axis, these traces will not look like typical DC I-V traces. Exchange the order of the swept variables
SRC1 and SRC2 on the grid.

e Check if you are sweeping one source with large variations and another with small variations. For example, say
that you are sweeping the base current and the collector voltage of a transistor by connecting a DC current
source at the base and a DC voltage source at the collector. Furthermore, say that you are using SRC1 to sweep
the base current and SRC2 to sweep the collector voltage. A DC bias-current sweep typically involves very small
increments - on the order of microamperes, for example. Inside the program, the SRC1 sweep always occurs
inside the SRC2 sweep, so the net effect is that the base current is changing more frequently. Because of the
small increments in the current sweep, proceeding from one current value to the next may not change the circuit
state (operating point) in the simulator. This causes the program to converge to the same solution as the
previous current value, resulting in jagged I-V curves.

e Check if you are measuring the DC current in the wrong direction. By default, positive current through a
two-terminal element, such as a resistor or ammeter, is measured as flowing from pin 1 to pin 2. To measure
current in the opposite direction, you can edit the schematic by changing the element's orientation, or specify the
current at a different pin, or change the orientation of the current probe.

e If you are having convergence problems during a swept DC simulation, reduce the step size of the parameter
being swept.

Adjusting Tolerance Parameters

Several tolerance parameters can be changed so that simulations are more likely to converge, although at the cost of
a somewhat less accurate result. These parameters include:
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Current relative tolerance ( I_RelTol )
Voltage relative tolerance ( V_RelTol )
Current absolute tolerance ( I_AbsTol )
Voltage absolute tolerance ( V_AbsTol )

The equations that are used to check for convergence apply to all analysis types, not just DC. In ADS, you can change
these parameters in the Options component on the Convergence tab.

Topology Check and Correction

By default, a topology check is performed before any simulation is executed. The topology check finds common circuit
errors that would lead to more serious errors later in the DC simulation. These errors are reported in the
Simulation/Synthesis Messages window. See Setting the Topology Checker Mode to learn how to turn the topology
checker on and off, and to change the error message format. However, it is recommended to keep the topology
checker turned on.

The topology check verifies the existence of the following conditions, some of which are corrected automatically by the
simulator if the topology checker is turned on:

e There are no degenerate nodes.
At least two components must be connected to each node. Degenerate nodes have only one device attached to
them, making it difficult for the simulator to solve the circuit. If the topology checker is on, the simulator
automatically corrects this problem by inserting a large resistor with a default value of 1e12 ohms from the
offending node to ground. The value of the resistor is controlled by the GMIN parameter in the Options
component.

e There is a DC path from every node to ground.
If the DC circuit simulation is to succeed, all circuit nodes must have a DC path to ground. This eliminates nodes
that float at an undefined DC voltage value and allows the DC simulator to find the bias point of all nodes in the
circuit. This error is commonly caused by two capacitors in series. If the topology checker is on, the simulator
corrects this problem automatically by inserting a large resistor with a default value of 1e12 ohms from the
offending node to ground. This adds a DC path to ground without affecting the circuit's performance. The value
of the resistor is controlled by the GMIN parameter in the Options component.

e There are no devices in series with current sources.
Devices in series with a current source create problems during DC simulation. This should be corrected manually.

e There are no loops of DC shorts, or voltage or current sources.
It is possible to create a circuit containing short-circuited DC loops that cannot be handled by the DC simulation.
For instance, if two ideal inductors are connected in parallel, they create a DC short-circuit loop. The DC current
in this loop is undefined; it can have any value without affecting the circuit solution. This should be corrected
manually.

e There are no devices parallel to voltage sources.
Devices parallel to a voltage source create problems during DC simulation. This should be corrected manually.

The following figures show examples of the topology conditions checked when the topology checker is turned on. The
simulator corrects the errors such as those shown in the first figure below by inserting a large resistor (default = 1e12
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ohms) from the offending node to ground. However, the simulator cannot correct the errors such as those shown in
the second figure, which you should correct manually. Additionally, the topology checker does not check and correct
any of these conditions through transmission lines.

By default a summary of the topological problems found is printed to the Simulation/Synthesis Messages window
when the topology checker is turned on. To see a list of all the nodes that have topological problems, set the message
format mode to verbose.

Degenerate nodes No DC path
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Common circuit errors corrected during topology check
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Common circuit errors not corrected during topology check

If the circuit fails to simulate due to topological problems, turn off the topology checker. This will eliminate all topology
checking, and simulations will proceed directly to the DC simulation stage. The DC simulator will speed up simulations
slightly, which may be helpful in rare cases where it is certain that the DC simulation will succeed despite the
topology.

 Note

Errors found by the topology checker almost always lead to DC simulation failures, so turning off the topology
checker is not recommended.

If you have existing circuits in which there are many topological problems, turning on the topology checker could
significantly speed up the simulation. In this case the topology checker corrects the common topological problems
before the circuit is simulated.

Setting the Topology Checker Mode

21




Advanced Design System 2008

The topology checker parameters are located with the simulator Options. These parameters enable you to turn the
topology checker on (default is TopologyCheck=yes ) and turn it off ( TopologyCheck=no ). You can also set the
warning messages format to summary (default is TopologyCheckMessages=summary ) or verbose (
TopologyCheckMessages=verbose ).

To change these settings in dialog boxes place an Options component on your schematic, open its setup dialog box,
then see the Misc tab. To turn on the topology checker, enable Perform topology check and correction. Disable the
setting to turn it off. To set the message format, choose Summary or Verbose for Format topology check warning
messages.

Checking Nodes and Pins

If the topology check fails, the offending nodes are highlighted in the Simulation/Synthesis Messages window. Choose
Simulate > Highlight Node to identify these nodes.

Unconnected Wire Errors

In the case of a circuit with a wire that is missing, a message such as the following can appear in the
Simulation/Synthesis Messages window during a simulation:

Warning detected by HPEESOFSIM during DC analysis "DC1".
Circuit as given has no unique solution.
A virtual resistance of 1 TOhms was added to each node.

In the case of unconnected wires or pins, choose Tools > Check Representation, then select Open connections and
click OK. All unconnected wires and components are highlighted, making them easily visible on the screen. Connect
these to the correct circuit node.

Port/Pin Mismatches

To check for mismatches between ports and named pins on an underlying schematic, use the Check Representation
feature. Choose Tools > Check Representation, then select Port/Pin mismatches and click OK. In a circuit without a
topology problem, the simulator reports the following:

Unconnected pins: 0
Port/Pin mismatches: 0

22



Advanced Design System 2008

Where a wire is missing between two pins, for example, the components and the disconnected pins will be highlighted
in red on the schematic, and a message such as the following will appear, indicating the coordinates of the
connectors:

Unconnected pins: 2
I_DC SRC1, pin 2 (2.500,-0.125)
BJT_NPN BJT1, pin 2 (3.250,0.375)

To clear the highlighting, choose View > Clear Highlighting.

 Note

Always ensure that there is no duplication of port numbers.

Impossible Circuits

A circuit can fail to have a solution. Examples of such impossible circuits are circuits with two DC current sources (or,
perhaps, current-mirror circuits) in series. The simulator attempts to analyze these circuits by adding a large resistor
in parallel with every node in the circuit. If the DC simulation then succeeds, the resistor value is increased as high as
possible (up to 1 Tohm). This allows the DC simulation to proceed, and usually to succeed. However, the offending
circuit node or nodes often cause problems with a subsequent harmonic balance simulation because the harmonic
balance simulator does not add these resistors. It is best to find the problem node and manually add a DC path (such
as a large resistor) to ground.

If virtual resistors were added to each node during DC simulation but the simulation still failed, look for circuit
problems such as loops of inductors and voltage sources.

Model Parameter Imax is Too Small

If the RHS_NORM oscillates between/among iterations, the reason could be that the diode's p-n junction in this circuit
conducts more than 1 A. The default values of Imax for nonlinear semiconductor devices are around 1 A. It is possible
that all device's p-n junction currents in a circuit do not exceed Imax after the circuit converges but have problems
converging during the iteration process because of the small Imax. The remedy is to increase nonlinear device model
parameter Imax to 1e3. For BSIM3, the model parameter is Ijth.

References for DC Simulation
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